Clearly APA: The NorQuest Guide to APA Style

Based on APA 6th edition
Clearly APA: The NorQuest Guide to APA Style

Based on APA 6th edition
Contributors

Mary Chan  
Diane Reid  
Leigh Dyrda  
Rebecca Hardie  
Judith Anderson  
Brooklin Schneider  
Dana Wight  
Barb Pearce  
Debra Bachman  
Jeff Jenkins  
Sandy Kram  
Vanessa Acordon  
Liz Fulton-Lyne  
Leah Townsend  
Eve Poirier  
Kath Zarft  
Marg Sheppard  
Dawn Witherspoon  
Gisele Ramgoolam  
Beth Vandenboogaard  
Jane Gong  
Michael Calaresu  
Sarah Bailey  
Students of Engl 2550  
for their feedback and suggestions

Much of this guide was adapted from the NorQuest Library website (found at libguides.norquest.ca/apa6). The library website contains a more detailed breakdown of a reference entry, samples for Engl 2550 Assignments 2a, 2b, and 2c, and updated information about Word document set-up. These online resources can be used in conjunction with this guide.

This work is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License.

This book is not approved by or associated with the American Psychological Association.
Contents

Part 1: Introduction 7

What is APA Style? 7
How to Use this Guide 7
Online Resources 8

Part 2: Academic Integrity and Plagiarism 9

Part 3: Document Formatting

Order of Paper 11
Running head 11
Order of components 12
Title page 12
Abstract 13
The body 14
Section headings 15
References page 17
Appendices 18

Word Formatting 20
Word 2013 for PC 20
Word 2011 for Mac 30

Part 4: Citations 39

What is a citation? 39
Punctuating citations 41
Block quotations 42
Citing The Broadview Anthology 43
Indirect citations 44
Citation examples in text 46
Part 1
Introduction

What is APA?

APA Style (also referred to as APA Format) is a set of rules about how to acknowledge other people’s words and ideas. It encompasses in-text citations, a References page, and structure and content (how the page looks and the order of components). APA is important because it is necessary to have agreed-upon, consistent rules about how to cite and reference.

APA is the style of citation and referencing commonly used in the social sciences. APA stands for the American Psychological Association, which is the professional organization that created and updates the guidelines. The APA has written a book, *Publication Manual of the American Psychological Association* (6th ed.), on which the information in this guide is based.

This book contains information about using APA Style. It is designed to be a concise reference guide that explains the rules of APA Style (including in-text citations and creating a References page), covers key concepts regarding plagiarism and academic integrity, and demonstrates how to set up a Word document to conform with APA.

How to Use this Guide

The guide is divided into five main sections. The first section contains information about using this book. The second section explains the importance of academic integrity and how APA can help prevent plagiarism. The third section explains what an assignment in APA Style looks like, and includes instructions on how to set up a Word document to conform with APA. In the fourth section is information about in-text citations. The fifth section explains references, and includes reference examples for different kinds of sources. The book ends with a sample essay.
Finding Information

If you are looking for general information, use the table of contents, which will direct you to the relevant section of the book, or use the section tabs at the side of each page. The labels at the bottom of each page describe the content found on that page. If you are looking for specific information, consult the index at the back of the book.

Online Resources

But wait, there’s more!

In addition to this guide, readers can use the APA guide on the NorQuest Library website (found at libguides.norquest.ca/apa6). The library website contains much of the information in this book, in addition to a more detailed breakdown of a reference entry, samples for Engl 2550 Assignments 2a, 2b, and 2c, and updated information about Word document set-up. You can also live-chat with the librarians and ask them questions.
Part 2
Academic Integrity and Plagiarism

Academic integrity means acting in a way that is consistent with the values of honesty, fairness, respect, and responsibility. Academic integrity includes distinguishing between the ideas, information, and words that are yours and those that are not.

As a student, you are expected to follow a code of conduct that promotes the principles of integrity. Many NorQuest students are in professional programs that have their own codes of conduct or professional guidelines. Think of academic integrity as an additional professional code, one that ensures fairness, accountability, and trust.

Plagiarism

Plagiarism is taking someone else’s words and ideas and passing them off as your own. In your classes, you will be engaging with other people’s ideas and conducting research. This is acceptable and, in fact, expected. However, when using information from other sources (such as other people’s words and ideas, and facts and statistics that are not common knowledge), you must carefully indicate what is and is not yours. Failure to do so constitutes plagiarism.

It is important to know that intent does not matter when determining whether or not plagiarism occurred. A finding of plagiarism is based only on what appears on the page. Unintentional plagiarism is still plagiarism. It is therefore crucial to understand what plagiarism is and how to avoid it.

What does plagiarism look like?

The following are some examples of plagiarism:

- Copying and pasting from another source (article, website, encyclopedia, book, etc.) without any proper attribution, such as quotation marks, citations, and/or an entry in the...
References page. Even one incorrect phrase is enough to constitute plagiarism.

- Failure to quote or cite a source properly (e.g., forgetting quotation marks and/or the citation), even if that source appears in the References page.
- A poor attempt at paraphrasing (putting an idea into your own words) that results in a passage that is too similar to the original, whether in terms of wording or sentence structure. This is still considered plagiarism even if there is a citation.

**How to avoid plagiarizing**

- Use APA Style correctly to cite and reference information. This book explains how to use APA.
- Ask your instructor for more clarification if you have questions.
- Take advantage of the NorQuest College student resources, including the Writing Centre, the Tutorial Centre, and the library.
- Leave yourself lots of time to complete assignments so that you are not rushed. Avoid putting yourself in a position where plagiarism could occur.
- If you need more time, it does not hurt to ask for an extension. If an extension is not granted, it would still be preferable to take a late penalty than to face the consequences of plagiarizing.
Part 3
Document Formatting
Order of Paper and Word Formatting

Order of Paper

Unless specified, some sections (such as abstracts and appendices) are not always required in an assignment. If you are unsure, check with your instructor.

Every page: Running head

Every page has a running head at the top that includes the title of the assignment in the upper left corner and the page number in the top right corner.

The running head appears inside the top margin of your page (that is, it should be in the top one inch or 2.54 cm of the page). See pages 24 and 35 of this guide for details on how to create a running head in Microsoft Word.

The running head on the first page is slightly different from the running head on all the other pages.

First page:

Running head: TITLE OF ASSIGNMENT 1

Second and subsequent pages:

TITLE OF ASSIGNMENT #
Note the punctuation and capitalization. The “R” in “Running head” is capitalized, but the “h” is not. The words “Running head” are followed by a colon (:).

In the running head, the title of the assignment appears in all capital letters and cannot exceed 50 characters, including spaces. If the title is too long, use a shorter version.

**Components**
An essay will have any or all of the following:

- Title page (required for all assignments)
- Abstract
- Text/Body of assignment (required for all assignments)
- References (required for all assignments)
- Appendices

**Title page**
The first page of every assignment is a title page.

The title page always includes the following information:

- Assignment title
- Student name
- Institution/College name

Some instructors might require the following information. Check to be sure.

- Course and section number
- Assignment name and number
- Instructor Name
- Date
Formatting the title page
The information should appear in the top half of the title page. Centre and double space the information.

Abstract
An abstract is a brief summary of the essay. It should include the main argument and major supporting points. It does not include quotations or any detail so specific that it needs to be cited. The abstract is comprehensive, covering all major points. Most assignments do not require an abstract. In English 2550, an abstract is required for assignment 2c.
The abstract is also short. The abstract is a maximum of 150 words.

ZOMBIE APOCALYPSE PREVENTION

Abstract
This paper argues that the most effective ways to prevent a zombie apocalypse involve providing sufficient supplies to local and regional groups who would best be able to adapt materials to the specific needs and terrain of that region. It uses examples from military and strategic studies to argue that a combination of barricades and strategic guerilla-style attacks would be most effective against the zombie hordes, especially if the defense groups were led by those with experience in stealth measures. It recommends that national governments and international organizations focus on areas where sharing resources and knowledge would be most efficient, including the scientific battle to eliminate zombies, and on finding zombie-free islands where survivors can relocate.

Formatting the abstract
If an abstract is required, it appears on the second page of the essay. The title of the abstract is the word Abstract, without any formatting (no quotation marks, italics, underlining, bold, etc.). Do not indent the first line.

The abstract gets its own page. Start the essay on the next page (page 3).

The Body
Begin your assignment at the top of the page. Provide your title, centred and with no additional formatting (no bold, italics, or underlining). Then begin your assignment. Indent new paragraphs 0.5 inches (1.27 cm).

Formatting the body
The entire assignment should be in Times New Roman 12-point font with one-inch margins all around. The text is double-spaced and left justified. All pages are numbered, starting with the title page as 1. Information about how to change settings in Word to conform with APA starts on page 20 of this book.
Section Headings

Headings divide the assignment into sections and help organize information. Headings appear where appropriate; not every paragraph requires a heading.

Formatting headings

Headings (which are different from the running head at the top of the page) appear within the body of the assignment. The formatting depends on the heading level.

Rules for formatting headings:

Level 1: Centred, bold, all major words capitalized
Level 2: Flush against left margin, bold, all major words capitalized
Level 3: Indented, bold, capitalize first word, end with a period. Start paragraph on same line.
Level 4: Indented, bold, italicized, capitalize first word, end with a period. Start paragraph on same line.

Level 5: Indented, italicized, capitalize first word, end with a period. Start paragraph on same line.

In the cases where the heading ends with a period (levels 3, 4, and 5), the next sentence is on the same line, rather than the next one. Also, while the headings for levels 3, 4, and 5 require only the first word be capitalized, remember that proper nouns (such as Edmonton) are always capitalized.

For examples of headings within a document, see the sample essay at the back of this book and the “APA6 Sample Paper” on the NorQuest Library APA website.

Examples

**Animals that Make Good Pets** (Level 1)

**Common Pets** (Level 2)

Dogs. Start paragraph... (Level 3)

*Small dog breeds.* Start paragraph... (Level 4)

*Pomeranians.* Start paragraph... (Level 5)

*Medium dog breeds.* Start paragraph... (Level 4)

*Nova Scotia Duck Tolling Retrievers.* Start paragraph... (Level 5)

**Uncommon Pets** (Level 2)

*Rodents and small mammals.* Start paragraph... (Level 3)

*Advantages of rodents.* Start paragraph... (Level 4)

*Disadvantages of rodents.* Start paragraph... (Level 4)

*Reptiles.* Start paragraph... (Level 3)

*Advantages of reptiles.* Start paragraph... (Level 4)

*Disadvantages of reptiles.* Start paragraph... (Level 4)

**Illegal Pets** (Level 2)

*Snakes.* Start paragraph... (Level 3)
The References page

The References page is the list of sources that were used in the assignment. Every source that you use in the assignment should appear in the References page, and every source that appears on the page should have been used in the assignment.

The entries are listed alphabetically according to author last name. The References page is not included in the word count of an assignment.

---


Formatting the References page

The References page starts on its own page. Centre the title, but do not bold it. If there is only one source, write Reference. If there is more than one source, the title is References.

The References page is double spaced. The entries appear in alphabetical order by author last name. Format the entries with a hanging indent, in which the first line of the entry is flush against the left margin, and the subsequent lines are indented 0.5 inches (1.27 cm). (See pages 28 and 37 for how to create a hanging indent in Word.)

For information about how to format the References page entry for different kinds of sources, see Part 5 of this book.

Appendices

An appendix (plural form appendices) contains detailed information that is relevant and useful, but too awkward to include in the body of the paper. Examples of appendices include a full list of survey questions, complete mathematical calculations, and brochures or pamphlets.

Formatting an appendix

The appendix appears after the References page. Start on a new page. If the paper has only one appendix, title it Appendix. If there is more than one appendix, then title each with a capital letter (Appendix A, Appendix B, etc.) in the order in which they appear in the body of the paper. The title is centred with no additional formatting (no bold, italics, etc.)

To refer to an appendix in the body of the paper, mention it in parenthesis.

Both Meals on Wheels and the Edmonton Food Bank define their client groups (see Appendices A and B).

The material in the Appendices is listed in the References page. The formatting of the Reference entry will depend on the type
of source. The following is an example for a brochure with no date.

Reference entry:

Edmonton Meals on Wheels. (n.d.). *Feeding body and soul.*

[Brochure]. Edmonton, AB: Author.

Sample Appendix:
Word Formatting

The next pages explain how to set up Microsoft Word to follow the rules of APA document formatting. Specifically, it demonstrates how to change the default settings in Word, meaning that any new documents that are created should automatically comply with APA rules.

Word for PC 2013

Setting a new default font in Word 2013 for PC

1. Open a new document in Word.

2. In the Home tab, locate the Font box. Then click on the little down-pointing arrow in the bottom right corner.

You should now see a Font dialogue box (a box that shows options for setting the font).

3. Change the font to Times New Roman. The font style is Regular and the size is 12.

4. To keep these settings for all future documents, click on the Set as Default button.
5. Click “OK” to change settings for all documents.

To change Paragraph and Spacing in Word 2013 for PC

1. In the **Home** tab, locate the **Paragraph box** and click on the little down-pointing arrow in the bottom right corner.

2. In the Paragraph dialogue box, set the **Alignment** to **Left**.

   The **Spacing** Before and After should be 0 pt.

   Line spacing is **Double**.

3. To apply these settings to future documents, click on the **Set as Default** button.
5. Make sure “All documents based on the Normal.dotm template” is selected, and click OK.

Double spacing: The shortcut
To double space quickly without having to go into Paragraph settings, select the text that you want double spaced or hit CTRL+A to select all the text in the body.

Option 1
In the Home tab, locate the Paragraph box. Find the Spacing button. When you click on it, you will see a list of spacing options. Select 2.0 to make the selected text double spaced.

Option 2
Hit CTRL+2 and all the selected text will double space.
Setting margins in Word 2013 for PC

1. In the Page Layout tab, locate the Page Setup box and click on the little down-pointing arrow in the bottom right corner.

A Page Setup dialogue box will appear.

2. In the Margins tab, set all the margins at **1 inch** or **2.54 cm**.

Click Set As Default to change the default settings.

4. Confirm the change to the default settings by clicking Yes.
Creating a running head in Word 2013 for PC

The running head appears inside the top margin of the page, that is, within the top one inch or 2.54 cm. The running head on the first page is different from the running head on subsequent pages, and Word must be set up to allow this.

1. In the Insert tab, locate the Header & Footer box and click the drop-down arrow next to Header. Alternatively, double click in the uppermost inch of the page (in the top margin), which will make the header menu appear.

2. A list of options will appear. Choose the option titled Blank.

3. In the ribbon, check Different First Page.
4. The cursor should now be positioned at the beginning of the header. Type “Running head:” followed by the title of your assignment in all capital letters, and then hit the TAB key until the cursor is at the right margin.

5. Click on the **Insert** tab, and then click on **Page Number**. A drop-down menu will appear. Select **Current Position** and then the first option, **Plain number**.

Your page number should now be inserted into the first-page header.
Creating the Title Page in Word 2013 for PC

Start the title page by creating the header (that is, the running head) as explained in the previous two pages.

Once you have created the first-page header, double click in the middle of the page to return the cursor to the main page.

Hit enter about three times, and then start typing the information required (see page 12). Remember to double space the information.

Page breaks in Word 2013 for PC

To start the second page of the assignment, it is best to insert a page break. A page break automatically starts a new page.

To insert a page break, place your cursor after the information that you want to keep on the title page. Then, under the Insert tab, click Page Break.

Page Break shortcut: The shortcut key for inserting a page break is CTRL+enter. Remember to place the cursor where you want the new page to start.
Running head on page two and subsequent pages in Word 2013 for PC

Because the header on the first page was set at Different First Page, you need to create the header for the rest of the pages. To do so, double click in the top margin (the uppermost one inch) of the second page.

Type the title of your assignment in all capitals (you do not need to type “Running head” on this page). Insert the page number by following the directions on page 25. If the default font is not Times New Roman 12, then change it. The second page header should look like this:

![Second page header illustration]

Double click in the main area of the page to get out of the header. The cursor will still be centred from the title page. To change this, go to the Home tab, and in the Paragraph box, click the left justify button (or hit CTRL-L for the shortcut).
**The References page in Word 2013 for PC**

To start the References page, type References (or Reference if there is only one source). Place the cursor immediately before the word and insert a page break (see page 26 for details). Make sure the word References is centred, either by going to the Home tab and clicking the centre button or by using the shortcut CTRL-E.

Hit enter and left justify the cursor.

**Hanging indents in the References page in Word 2013 for PC**

The list of entries in a References page appears with a hanging indent. A hanging indent means that the first line of the entry is placed against the left margin, and all subsequent lines are indented half an inch.

To set a hanging indent, click on the downward-pointing arrow in the bottom right corner of the **Paragraph box**.

A Paragraph dialogue box will appear. Under **Indentation**, locate the **Special** drop-down menu. Select **Hanging** and make sure that the amount is 0.5 inches or 1.27 cm.

Click **OK** to save changes.
Hanging indents (a second way)
An alternative way to set hanging indents involves taking a closer look at the ruler. Find the two triangles that point to each other in the left-hand corner of the top ruler. With the text you want changed highlighted, carefully click on the bottom triangle and drag it 0.5 inches (1.27 cm) to the right.
Formatting Word 2011 for Mac

Changing the default font in Word 2011 for Mac

1. In the very top menu bar, select Format and then Font...

A Font dialogue box will appear.

2. Change the font to Times New Roman Regular, 12 pt.

3. Click the Default... button in the bottom left corner of the box.

4. A new box will pop up.

Click Yes to change the default font settings. This means that the current document and all new documents will use Times New Roman 12 automatically. This change should also apply to running heads and page numbers.
Changing the default paragraph and line spacing

1. In the top menu bar, select **Format** and then **Style**...

The Style dialogue box will appear.

2. Ensure that the **Normal** style is highlighted, and then click the **Modify**... button.
This will bring up the Modify Style dialogue box.

3. Click on the drop-down menu in the bottom left-hand corner that reads **Format**.

4. In the drop-down menu that appears, go to **Paragraph**...

**TIP: Shortcut for double spacing**

The shortcut key for double spacing in Word for Mac is **Command+2**. Keep in mind that this will not change the default setting of any new documents.
You should now see the Paragraph dialogue box.

5. In this box, make sure the **Alignment** is **Left**.

Change the **Spacing** to **0 pt** for both Before and After.

**Line spacing** should be **Double**.

6. Click **OK**.

You should see the Style box again.

7. Click the **Apply** button in the bottom right corner to save your changes!

All future documents that you start in Word from now on should conform to the changes you made.
Setting the margins in Word 2011 for Mac

1. In the top menu bar, select **Format** and then **Document...**

The Document dialogue box will appear.

Make sure you are in the **Margins** options

2. Set all four margins at **1"** (one inch) or **2.54 cm**.

3. Click **Default...** to save the changes as standard.

4. Click **Yes** to confirm the changes to the default settings.
Running heads in Word 2011 for Mac
Setting a Different First Page for headers

1. Under **View** in the top menu bar, select **Header and Footer** OR **double-click** in the top margin of the page where the header would be.

2. When the **Header and Footer** menu appears on the menu ribbon, check **Different First Page**. (Do this before writing anything in the header.)
Setting up the running head and page number in Word 2011 for Mac

After setting the header to be different on the first page, make sure the cursor is in the header itself (top inch of the page).

1. On the title page, type “Running head:” and then the title of your assignment in all caps (you can use a shortened version to make it fit one line).

2. Hit the \textbf{tab} key twice. The cursor should move to the right side of the header.

3. Under the \textbf{Header and Footer} tab, click \textbf{Page #}. A page number should be automatically inserted where the cursor is.

4. To return to the document, click \textbf{Close} or double click anywhere on the main part of the page.

Once you have created the first-page header, double click in the middle of the page to return the cursor to the main page.

Hit enter about three times, and then start typing the information required (see page 12). Remember to double space the information.
Follow the same procedure to set up the running head on page 2 as well, since the first page is different. Once page 2 is set up, the rest of the pages will duplicate that header.

**Inserting a page break in Word 2011 for Mac**

A **page break** is where a new page in the document starts. It can be used for the section of an assignment that must start on a new page, like the References page.

1. Place the cursor where the new page will start.

2. In the top menu bar, click **Insert**. Then go to **Break** and then select **Page Break** in the drop-down menu.

**TIP: Shortcut key for Insert Page Break**

To insert a page break, place the cursor where the new page should start, and then hit **Command+Shift+Return**.

**Hanging indents for Word 2011 for Mac**

Here are two ways to set a hanging indent in the References page.

**Method One**

1. Place the cursor at the beginning of the section where you want the hanging indent to start, or select the text that you want to be formatted.

2. Under **Format** in the top menu bar, go to **Paragraph...** to get the Paragraph dialogue box.
3. In the Indentation section, under Special, select Hanging.

Set the indent to 0.5 inches or 1.27 cm.

4. Click OK.

**Hanging indents: Method Two**

1. Select the text to be formatted.

2. Look at the ruler above the document. Note the two triangles pointing to each other with the little rectangle underneath.

   (If you do not see a ruler, go to the View menu at the top and select Ruler from the drop-down menu.)

3. With the mouse, click and hold the bottom triangle and drag it 0.5 inches (half an inch) to the right. Let go. The selected text should now be formatted with a hanging indent.
Part 4
Citations

What is a citation?

When using information (words, ideas, facts) from another source, it is essential to acknowledge where it came from and where to find it. This acknowledgement is done through a combination of quotation marks, in-text citations, and References page entries. The term “in text” indicates that the citation is located in the body (the text) of the assignment.

For professional Italian soccer clubs, “attendance plays no role in the winning performance” (Armenta & Betta, 2010, p. 76).

An in-text citation includes:
• Author(s) last name(s)
• Publication year
• A page number (for quotations)

Notice that the three pieces of information are separated by commas:

(Last Name[s], YEAR, p. #)
(Armenta & Betta, 2010, p. 76)

The first word in a citation matches the first word of a References page entry. Every in-text citation has a corresponding entry in the References page.

If you mention the author within the sentence, the publication year follows in parentheses and only the page number appears after the quotation.

According to Armenta and Betta (2010), for professional Italian soccer clubs, “attendance plays no role in the winning performance” (p. 76).

Basically, the information in the citation gets broken up in the sentence. Keep in mind, however, that all three pieces of information must still be present. Also notice that when the author names are in the parentheses, an ampersand (&) is
used instead of the word “and”. However, if the authors are mentioned in the text, the word “and” is used.

The author last names and the publication year always go together in the body text: Armenta and Betta (2010).

If there are no page numbers, use paragraph numbers instead.

In the system of total football, “all 11 players, including the goalkeeper, were responsible for keeping the ball moving forward” (Burns, 2011, para. 17).

If the source is too long to count all the paragraphs, it is acceptable to use a heading from within the article and a paragraph number under that heading (begin counting after the heading).

In the system of total football, “all 11 players, including the goalkeeper, were responsible for keeping the ball moving forward” (Burns, 2011, Playing Styles, para. 4).

When quoting, as in the examples above, you must include a page number in the citation. Sometimes, though, it might be appropriate to **paraphrase**, that is, to convey someone else’s idea in your own words. Paraphrasing must still be cited, because even if the words are yours, the idea/information is not. The citation for a paraphrase is the same as for a quotation, but with no page numbers.

Others have studied the correlation between attendance at soccer matches and outcomes (Armenta & Betta, 2010).

Keep in mind that your paraphrase must be substantially different than the original in terms of wording, phrasing, and sentence structure. Similarities between the paraphrasing and the original passage can lead to plagiarism. If you struggle with rephrasing the information, then contact the Writing Centre for help.

**No author or no date**

If the source has no identifiable individual author, look at the information to see if there is an institutional author.
Common causes of accidents include distracted driving and driving while impaired (MADD, 2014).

If there is no author of any kind, use the title in place of the author name. If the source is an article or chapter, put the title in quotation marks. If the source is a book or website, use italics. Capitalize all important words.

Rental rates in central Vancouver rose from 25% to 38% from 2001 to 2006 (BC Housing Statistics, 2011, para. 4)

If there is no date, write “n.d.” (which stands for “no date”).

(Thorstein, n.d., p. 901)

**Group as author**

To cite a group (e.g., an association or governmental agency) as an author, spell out the group’s full name in the first citation. If the group’s full name is long and awkward, or if the abbreviated name is well-known, use the abbreviation in all subsequent citations. If the abbreviation is short or if it is not well-known, continue to spell out the name in citations. Make sure there is enough information in the citation for the reader to locate the corresponding References page entry. See page 56 for more examples.

(College of Licensed Practical Nurses of Alberta [CLPNA], 2015, p. 56)

**Punctuating citations**

Parenthetical citations are citations enclosed in round brackets that appear after a quotation or paraphrase. The citation is placed after the closing quotation mark and before the period.

For professional Italian soccer clubs, “attendance plays no role in the winning performance” (Armenta & Betta, 2010, p. 76).

To remember this rule, treat the parenthetical citation as an essential part of the sentence, which means that it belongs with the sentence, that is, before the sentence ends at the period.
Block quotations

A quotation of 40 or more words must be set off as a block quotation.

For block quotations, start the quotation on a new line. Indent the entire quotation 0.5 inches (1.27 cm). There are no quotation marks. The citation goes after the period, not before. After the quotation, continue the paragraph flush against the left margin (left justify), which indicates that what follows is still a part of the previous paragraph.

Correct block quotation:

The jump from programming robots with soccer skills to using them in more challenging environments will be difficult to overcome:

A house or apartment and the possessions it contains may not change much over time, but it is more complex to move about in. It is harder still for an AI program to map a completely unfamiliar urban environment without any immediately identifiable landmarks. (Cohen, 2011, p. 10)

Cohen is still optimistic about the prospects, however.

Incorrect block quotation:

The jump from programming robots with soccer skills to using them in more challenging environments will be difficult to overcome:

“A house or apartment and the possessions it contains may not change much over time, but it is more complex to move about in. It is harder still for an AI program to map a completely unfamiliar urban environment without any immediately identifiable landmarks” (Cohen, 2011, p. 10).

Cohen is still optimistic about the prospects, however.
Formatting Block Quotations

<table>
<thead>
<tr>
<th>Quotation in text</th>
<th>Block Quotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Less than 40 words</td>
<td>40 words or more</td>
</tr>
<tr>
<td>Quotation marks</td>
<td>No quotation marks</td>
</tr>
<tr>
<td>Citation before the period</td>
<td>Citation after period</td>
</tr>
</tbody>
</table>

Citing The Broadview Anthology of Expository Prose

For English 2550, the textbook is cited in an unusual way because the book is a collection of readings that have been already published. As a result, each reading has two sets of publication information, including two publication dates: 1) the original date of publication and 2) the date that the *Broadview Anthology* (the book) was published.

To cite a reading from the *Broadview Anthology*, include both dates, in chronological order, separated by a slash (/).

The Flynn effect describes the statistical rise of I.Q. scores over time (Gladwell, 2007/2011, p. 544).

Gladwell (2007/2011) defines the Flynn effect as the statistical rise in I.Q. scores over time (p. 544).

Complete publication information for each reading in *The Broadview Anthology of Expository Prose* is located in the acknowledgements starting on page 705.

Any book that reprints already published material will be cited in this manner.
Indirect Citations
(Citing a quotation that a source quotes)

Sometimes you will want to use a quotation that one of your sources has quoted. Ideally, you should find the original source, and cite and reference it accordingly. It is always best to see a quotation or information in the original context. However, sometimes it is not possible to find the original. In these cases, you can quote what your source has quoted by using an indirect citation.

The following passage is from an article by Siebert, who includes a quotation from Downes (bolded).

Passage written by Siebert:
Nonetheless, it would seem that modern commentators on the Dictionary take Johnson’s authoritarian stance for granted. To Rackstraw Downes, “It is clear that for Johnson the great value of his work will be to promote purity and correctness; and by establishing these, to provide a permanent standard of usage. The definitions themselves are intended to be controlling rather than descriptive, and to exercise a positive effect on the language.” (Siebert, 1986, p. 486)

To quote what is bolded, acknowledge that the quotation is originally from Downes by mentioning Downes in the sentence. Indicate where you found the quotation by using Siebert in a modified citation “as cited in”.

Downes, for example, argues that “The definitions themselves are intended to be controlling rather than descriptive, and to exercise a positive effect on the language” (as cited in Siebert, 1986, p. 486).

Downes characterizes the definitions as “controlling rather than descriptive” (as cited in Siebert, 1986, p. 486).

Siebert is the source that appears in the References list, because Siebert’s article is the one that was read. Downes does not appear.
Quoting a passage that includes paraphrased material (Citing information a source cites, but does not quote)

If you want to quote a sentence that contains citations from a paraphrase or summary, quote the entire sentence, including the original citations. Cite normally and list the source that you read in the References page.

If this appeared on page 155 in an article written by Sowolski and Meyer (2015):

Any variation in pattern could indicate a significant disruption. Birds have been found to stay on the same migratory paths from year to year (Li & Sanchez, 2015; Tegan et al., 2014).

Quote it this way:

Sowolski and Meyer (2015) note that birds “stay on the same migratory paths from year to year (Li & Sanchez, 2015; Tegan et al., 2014)” (p. 155).

or

Another environmental benchmark is bird migration patterns, because “birds have been found to stay on the same migratory paths from year to year (Li & Sanchez, 2015; Tegan et al., 2014)” (Sowolski & Meyer, 2015, p. 155).
Citation examples in text

Source with one author or editor

(Balzer-Riley, 2012) OR
Balzer-Riley (2012) concludes that…

Direct quotation:
(Balzer-Riley, 2012, p. 321)

Source with two authors or editors

All times:
(Sherrit & Soyinka, 2013) OR
Sherrit and Soynika (2013) write that…
Direct quotation:
(Sherrit & Soyinka, 2013, p. 59)

Source with three to five authors or editors

First time:
(Sommers, Johnson, & Beery, 2007) OR
Sommers, Johnson, and Beery (2007) conclude that…

Direct quotation:
(Sommers, Johnson, & Beery, 2007, p. 82)

Second and subsequent time:
(Sommers et al., 2007, p. 82)

Source with six or more authors or editors

All times:
(Potter et al., 2014) OR
Potter et al. (2014) conclude that…

Direct quotation:
(Potter et al., 2014, p. 365)

Book in more than one volume

(McGrath, 2001) OR
McGrath (2001) concludes that…

Direct quotation:
Source with author unknown (use title as author)

(Merriam-Webster’s Collegiate Dictionary, 2003) OR
Merriam-Webster’s Collegiate Dictionary (2003) defines…

Direct quotation:
(Merriam-Webster’s Collegiate Dictionary, 2003, p. 346)

Source by a group author as publisher (company, association, institution, government)

(NorQuest College, 2004) OR
NorQuest College (2004) reports that…

Direct quotation:
(NorQuest College, 2004, p. 54)

Chapter, article, essay, story or poem in a collection or edited book (Cite the authors, not the editors.)

(Comrie, Andrews, & Tarlier, 2014) OR
Comrie, Andrews, and Tarlier (2014) conclude that…

Direct quotation:
(Comrie, Andrews, & Tarlier, 2014, p. 538)

Book with reprinted material from a book, magazine or journal in a collection (Cite the authors, not the editors)

(Gladwell, 2007/2011) OR
Gladwell (2007/2011) proposes…

Direct quotation:
(Gladwell, 2007/2011, p. 546)

Encyclopedia entry, author known

(Hoag, 2012) OR
Hoag (2012) determines that…

Direct quotation:
(Hoag, 2012, p. 858)
Encyclopedia entry, author unknown

(“Piano”, 2005)

Direct quotation:
(“Piano”, 2005, p. 416)

Newspaper article with letter before page number

Not all newspapers/newsletters will have a letter before page number

(Bennett, 2015) OR
Bennett (2015) indicates that….

Direct quotation:
(Bennett, 2015, p. A6)

Brochure with no publication date

(Public Health Agency of Canada, n.d.) OR
According to the Public Health Agency of Canada (n.d.), …

Direct quotation:
(Public Health Agency of Canada, n.d., p. 2)

Government report, publisher same as author

(Statistics Canada Health Statistics Division, 2006) OR
According to the Statistics Canada Health Statistics Division (2006), the health of Canadians is…

Direct quotation:
(Statistics Canada Health Statistics Division, 2006, p. 22)

Source with no page numbers

(Sinnema, 2008) OR
Sinnema (2008) resolves that…

Direct quotation:
(Sinnema, 2008, para. 11)
ONLINE SOURCES

Website, author unknown, no date

(Multitasking While Driving, n.d.)

Direct quotation:
(Multitasking While Driving, n.d., para. 4)

Website, author known

(Smith & Segal, 2015) OR
According to Smith and Segal (2015), the…

Direct quotation:
(Smith & Segal, 2015, para. 1)

Direct quotation with heading:
(Smith & Segal, 2015, Diagnosing schizophrenia, para. 1)

Website of an association, group as author

(Alberta Therapeutic Recreation Association, n.d.) OR
According to the Alberta Therapeutic Recreation Association
[ATRA] (n.d.), a recreation therapist…..

Direct quotation:
(Alberta Therapeutic Recreation Association, n.d., para. 1)

Online encyclopedia, NOT from a library-subscription database
(use for Wikipedia)

(“Emily Carr”, n.d.) OR
In the article “Emily Carr” (n.d.), there is a list of …

Direct quotation:
Use paragraph numbers or headings:
(“Emily Carr”, n.d., para. 2) OR (“Emily Carr”, n.d., Legacy, para. 2)

Statistics Canada report on a website

(Statistics Canada, 2006) OR
According to Statistics Canada (2006), Farsi is the mother
tongue of…

Direct quotation:
(Statistics Canada, 2006, para. 6)
**Course website/Moodle site**

(NFDN 2007 Moodle Companion Guide Answer Key, n.d.)

Direct quotation:
(NFDN 2007 Moodle Companion Guide Answer Key, n.d., para. 10)

**Online forum post, author’s screen name only available**

(Ilovemycat!, 2009)

Direct quotation:
(Ilovemycat!, 2009, para. 3)

**Weblog/blog post, author’s proper name available**

(Bernstein, 2007) OR
Bernstein (2007) proposed that…

Direct quotation:
(Bernstein, 2007, para. 2)

**Weblog/blog post, author’s screen name only available**

(Mo, 2008) OR
According to blog poster Mo (2008), embryonic stem cells…

Direct quotation:
(Mo, 2008, para. 1)

**VIDEO AND AUDIO**

**Motion picture (videorecording in VHS or DVD format)**
Cite the producers and writers

(Noyce, Olsen, & Pilkington, 2002)

**Audio recording (cassette recording or CD format)**
Cite songwriters, not performer

(Cavanaugh, Morgan & Stock, 2009)

**Video weblog post (YouTube), author’s proper name available**

(Pink, 2009)
**Video weblog post (YouTube), author’s screen name only available**

(DEBSBS, 2008)

**Audio podcast**

(CBC Radio, 2009)

**IMAGES AND OTHER**

**Personal communication (letters, emails, personal interviews, phone conversations)**

Personal communications are not included in the References page. APA requires only a citation in text. In the citation, include the author’s initials in addition to the author’s last name and provide a date that is as specific as possible.

(J.J. Doe, personal communication, December 3, 2008)

**Classical works (such as the Bible, Qur’an)**

Classical works such as the Bible, Qur’an or ancient Greek and Roman works do not appear in the References page. Cite the work in the text only. You may cite the year of the translation or version you used.

(1 Cor. 13:1, Revised Standard Version)
(Qur’an 5:3-4)
(Aristotle, trans. 1931)

**Figure reprinted from a journal (includes charts, graphs, photographs, drawings or other depictions, NOT tables)**

Caption under figure:

Figure reprinted from a website (includes charts, graphs, photographs, drawings or other depictions, NOT tables)

Caption under figure:
Part 5
The References page

What is a References page?
The References page is a list of the sources that were quoted, cited, and paraphrased in the assignment. Every source that appears in the References page is used in the assignment, and every citation in the assignment corresponds to an entry in the References page.

The References page appears after the assignment. It starts on a new page and lists the sources according to author last name. The page is double spaced, and there are no extra large spaces in between entries. The entries appear with a hanging indent. For specific information about how to format a References page, see Part 3 of this book.

The Reference entry
The basic format for an entry in the References page is

Author. (YEAR). Title. Additional Publication Info.

Note the punctuation, including all the periods.

Author names in References page
The format for author names is

Last name [comma] [space] First Initial [period] [space] Middle Initial [period]

Vidic, M. K.

Multiple authors are separated by a comma, and an ampersand (&) is used before the last author.

Vidic, N. K., Scholes, P. S., & Ferguson, A. D.

Notice that commas serve two functions: First, they separate the last name from the initials, and secondly, they separate the different author names.
Order of names

If a source has more than one author, list the names in the order that they appear on the title page/first page. For example, a book with the authors listed as Cohen, Barnaby, and Alves on the title page would appear in the same order in the References entry, and not as Alves, Barnaby, and Cohen. The References list overall is organized alphabetically according to the first word of each entry. See page 17 for an example.

No author name

If there is no identifiable author, determine whether an association or institution could be used instead. If not, then use the title in place of the author name, moving the title to the beginning of the entry.


Editors instead of authors

To reference an entire book that has editors instead of authors, use the editors’ names followed by the parenthetical abbreviation (Ed.) or (Eds.), which indicates Editor or Editors.


However, most edited books are a collection of chapters or articles written by different authors. If you are using an individual chapter or article, then follow the Reference entry format for a “Chapter, article, essay, story, or poem in a collection or edited book” that is on page 66.

Suffixes and lettered credentials

Do not include honorifics like Dr. or degrees like Ph.D. or R.N., even if they appear with the author names. Include suffixes such as Jr. and III, set off by a comma.

Multiple authors
There are different rules for dealing with multiple authors in the References page, in-text citations, and in the body of the assignment.

MULTIPLE AUTHORS IN THE REFERENCES PAGE
If there are up to and including seven authors, list all authors’ names in the References page entry.

Wan, G. Y., Tulle, W. O, Tree, T. P., Foreman, V. Q., Fine, C.,

If there are eight or more authors, list the first six authors’ names, then use an ellipsis (…), and then the last author’s name.

Wan, G. Y., Tulle, W. O, Tree, T. P., Foreman, V. Q., Fine, C.,

MULTIPLE AUTHORS IN PARENTHETICAL CITATIONS
If there are 1–2 authors, cite all the authors all the time.

All citations: (Wan & Tulle, 2013, p. 96)

If there are 3–5 authors, cite all the authors the first time and the first author et al. any subsequent times.

First citation: (Wan, Tulle, Tree, Foreman, & Fine, 2013, p. 96)
Subsequent citations: (Wan et al., 2013, p. 101)

If there are six or more authors, cite the first author followed by et al. all the time.

All citations: (Wan et al., 2013, p. 96)

MULTIPLE AUTHORS IN BODY TEXT
If there are 1–2 authors, write all authors’ names all the time, with “and”.

All citations: Wan and Tulle (2013) mention that…
If there are 3–5 authors, write all the authors’ names the first time (using “and”), and then use “First Author et al.” for subsequent citations.

First citation: Wan, Tulle, Tree, Foreman and Fine (2013) believe...

Subsequent citations: Wan et al. (2013) believe...

If there are 6 or more authors, write the first author’s name followed by et al. all the time.

All citations: According to Wan et al. (2013), ...

GROUP AS AUTHOR

Always write out the group name in the first citation. If the abbreviated group name is well known or if the name is long or awkward, abbreviate the name in subsequent citations. Include the abbreviation in the first citation.

First citation in text
North Atlantic Treaty Organization (NATO, 2010)

First parenthetical citation
(Alberta Health Services [AHS], 2009, p. 45)

However, if the abbreviated name is not recognizable and the group name is short, continue writing out the entire name.

All citations in text: European Pug Society (2014)

All parenthetical citations: (European Pug Society, 2014)

Publication year

For almost all types of sources, you need only the year of publication. For magazines and newspapers, use the year and the specific date/month/season of publication provided.


If there is no publication date, use (n.d.), which stands for “no date”.

Titles

Titles in APA Style are formatted differently, depending on
a) the type of source, and
b) whether the title appears in the body of the assignment or
in the References page.

Titles in the References page
For longer works (such as books, journals, magazines and
websites), italicize the title.

Newsweek (magazine)
Scientific American (magazine)
International Business and Management (journal)
Principles of manual sports medicine (book)
Intersections: Readings in the sciences and humanities (book)

Note how the capitalization rules are different in the examples
above.
- In journal and magazine titles, capitalize the important
  words.
- In all other titles, such as those of books and websites,
  capitalize the first word, any word that immediately follows
  a colon (:), and any word that would normally be capitalized
  (proper nouns like Canada or Thompson).

In a References page, for shorter works (like articles and
chapters) that are found in a longer work:
1. Do not format the title at all. That means no italics, no
   quotation marks, etc.
2. Capitalize the first word, any word that immediately follows
   a colon (:), and any word that is a proper noun.

   Waiting for a goal.
   Larks and owls: College student sleep patterns and academic
   success in Canada.
Titles in the body of the assignment

In the body of the assignment, the formatting rules for titles are different. For all sources (books, magazines, articles, websites), capitalize all the major words. Additionally, for longer works, such as books, journals, magazines, and websites, put the title in italics; for shorter works, such as chapters and articles, put the entire title in quotation marks.

Review of References page capitalization rules

Always capitalize:
• All words at the beginning of a title
• Any word that appears immediately after a colon
• Proper nouns (i.e., a name that is always capitalized, like a person’s name or the name of a city or country)

For book and website titles, capitalize the first word, any word that immediately follows a colon, and any proper noun. For journal and magazine titles, capitalize all important words. For article titles, capitalize the first word, any word that immediately follows a colon, and any proper noun.

<table>
<thead>
<tr>
<th>References page</th>
<th>Body text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Book title</td>
<td></td>
</tr>
<tr>
<td><em>The Oxford anthology of British poetry</em></td>
<td><em>The Oxford Anthology of British Poetry</em></td>
</tr>
<tr>
<td>Journal or magazine title</td>
<td></td>
</tr>
<tr>
<td><em>Foreign Affairs</em></td>
<td><em>Foreign Affairs</em></td>
</tr>
<tr>
<td>Article title</td>
<td></td>
</tr>
</tbody>
</table>
The Reference entry in detail

Entries in the References page are formatted and structured according to the kind/type of source. For every type of source, the entry will follow the same rules. Identify the kind of source, and then use the example entries in this book as a template for your own References page.

The following is an explanation of how to create a Reference entry for common sources that you will encounter: an article in a scholarly journal; a chapter/article in an edited book with multiple contributors; a reading in *The Broadview Anthology of Expository Prose*; and a website with a group author. Remember that punctuation (every comma, period, parenthesis) matters.

**ARTICLE IN A SCHOLARLY JOURNAL (DATABASE OR WEB)**

The format for an article in a scholarly journal is


**Volume number**
- Write the number only, not “Vol. #”
- The number is italicized.

The volume number indicates how many years the journal has been publishing (e.g., volume 2 was published in the journal’s second year of existence).
Issue number
• Appears in parentheses () immediately after volume number.
• Use a comma after the closing parenthesis.
• The issue number and parentheses are not italicized.
• There is no space between the volume number and the issue number.
• If there is no issue number:
  * Journal of Pathology, 5, 98–105.

The issue number indicates the number of the issue published in one year. For example, issue 2 indicates that is the second issue of the year. Most journals publish multiple times per year, though not as frequently as magazines and newspapers.

Page numbers
• No “pp.” for journal articles
• Provide inclusive page numbers (use the first to last page of the article, not the pages that you cite specifically).
• Use a period after the page numbers.

DOI (Digital Object Identifier)
• Write lower-case “doi” followed by a colon (:) and then the DOI itself.
• No space between the colon and the DOI
• No punctuation after the DOI.

Recently, articles available online have been published with Digital Object Identifiers (DOIs), which are strings of numbers and letters that are unique to the article. Think of them as serial numbers for articles that make them easier to search for.

URL (Web address)
• Provide only if there is no DOI
• Use “Retrieved from URL”
• No punctuation at the end
• No retrieval date required, unless the source material might change (e.g., wikis)

If there is no DOI and the article was found using a library database, include a URL instead. At NorQuest, the following
list of entry page URLs is acceptable for the use of these databases. Otherwise, you must locate the homepage URL of the online journal, even though that is not where you accessed it.


**Gale databases:** Retrieved from http://find.galegroup.com/gps/start.do?prodId=IPS&userGroupName=edmo88243

**ProQuest databases:** Retrieved from http://proquest.umi.com/pqdweb?RQT=302&COPT=REJTPUcwJkIOVD0wJlZFUj0y&clientId=59668&cfc=1

If the article is from a web-based (not library subscription database) online journal article, cite the home page of the journal:

Retrieved from http://www.jdentaled.org/

Reference entry for scholarly article with URL instead of DOI:


**CHAPTER, ARTICLE, ESSAY, STORY OR POEM IN A COLLECTION OR EDITED BOOK**

The format for a chapter or article in an edited collection is:

Author, B. F., & Author, W. R. (Year). Title of article/chapter. In E. E. Editor, & D. I. Editor (Eds.), *Title of book* (additional information, pp. ##–##). Place of publication: Publisher.

**Editors**
- Before the editors’ names, write “In”.
- Editors’ names and initials are not reversed, but written “Initials Last Name”.
- Follow the editors’ names with (Eds.), which indicates that they are the editors.
- Comma after (Eds.)

**Additional Information**
- Additional information can include the edition or volume number, if that applies.
- If there is no information about a volume or an edition, do no include it in the Reference entry.

(2nd ed., Vol. 3, pp. 455-490)
(Canadian ed., pp. 78-124)

**Page Numbers**
- For books, use “pp.” before the page numbers.
- Provide inclusive page numbers for the articles (use the first to last page of the article, not the pages that you cite specifically).
- After the closing parenthesis, put a period.

**Place of publication**
- Provide the city and abbreviated state or province.
- If the city is outside the USA or Canada, provide the city and country.
If there are multiple locations, provide the first one.
Put a colon (:) after the place of publication.

**Publisher**
- Omit “Inc.”, “Co.”, and “Publishers”, which are extraneous.
- Include “Press” and “Books” if they appear in the publisher’s name.
- End with a period.

**ARTICLE IN A BOOK WITH REPRINTED MATERIAL**
Some books, such as *The Broadview Anthology of Expository Prose*, are collections of readings that have already been published. The Reference entry for those readings must include both sets of publication information: that of the anthology, and that of the original.

The entry for reprinted material is like the entry for a chapter or article in an edited book, but with the original information added to the end. Find the original publication info in the *Broadview Anthology’s* Acknowledgements section (p. 705).

<table>
<thead>
<tr>
<th>orange = Broadview information</th>
<th>purple = original publication information</th>
</tr>
</thead>
<tbody>
<tr>
<td>author of article</td>
<td>Anthology publication year</td>
</tr>
<tr>
<td></td>
<td>anthologiction title</td>
</tr>
<tr>
<td></td>
<td>place of publication</td>
</tr>
<tr>
<td></td>
<td>publisher</td>
</tr>
<tr>
<td></td>
<td>original journal</td>
</tr>
</tbody>
</table>

**Original publication information**
- End the first part of the Reference entry with a period
(after the publisher name).

- Then start a parenthetic phrase and write “Reprinted from”.
- Use as much information as you have, but no original page numbers.
- The format for the information depends on the type of source that the information was in. The above example is for a scholarly journal article. See page 66 for examples for a magazine and for a book.
- No punctuation after the closed parenthesis at the end.

**WEBSITE WITH A KNOWN AUTHOR**

For a website with a known author, use the following format:

Author, V. V. (Year). *Title of website*. Retrieved from URL


A group (institution, organization, government agency or department) can be credited as the author.


Note that there is no period or any punctuation after the URL.
Reference examples

**BOOKS**

**Book with one author**

**Book (edition) with up to seven authors**

**Book (edition) with eight or more authors or editors**

**Book in more than one volume**

**Book with author unknown**

**Book by a group author as publisher (company, association, institution, government)**

**Book with editor(s) instead of author**
Chapter, article, essay, story or poem in a collection or edited book

Book with reprinted material from a magazine in a collection

Book with reprinted material from a book in a collection

Encyclopedia entry, author known

Encyclopedia entry, author unknown
E-BOOKS

E-books are cited using a DOI (digital object identifier) if there is one. Copy and paste this to ensure it is correct. If there is no DOI, cite e-books from a database using the home page URL of the e-book database as below. If you have to divide a URL between lines, split it BEFORE any punctuation and do not add a hyphen. No retrieval date is required.

For ABC Clio: Retrieved from http://ebooks.abc-clio.com


E-book from a library-subscription database

E-book entry or chapter from a library-subscription database

E-book entry with no author from a library-subscription database
E-book from a website, NOT from a library subscription, full-text database

Online encyclopedia, NOT from a library-subscription database

ARTICLES AND OTHER PRINT SOURCES
Magazine article (Print)

Journal article (1 author) (Print)

Journal article (2 authors, journal paginated by issue) (Print)

Journal article, no issue number (3–7 authors) (Print)
Journal article (more than 7 authors) (Print)

Newspaper article (Print)

Editorial in magazine or newspaper (Print)

Brochure with no publication date

Government report, publisher same as author (Print)

DATABASE ARTICLES
Journal articles are cited using a DOI (digital object identifier) which will appear as part of the article information. Copy and paste this to ensure it is correct.
If there is no DOI, choose from the appropriate database provider below, and copy and paste the URL provided:


ProQuest databases: Retrieved from http://proquest.umi.com/pqdweb?RQT=302&COPT=REJTPUcwJkI0VD0wJlZFUj0y&clientId=59668&cfc=1

If it is a web-based (not library subscription database) online journal article, cite the home page of the journal: Retrieved from http://www.jdentaled.org/ (NOTE: no retrieval date)

**Journal article with a DOI (digital object identifier)**


**Journal article from a library-subscription, full-text DATABASE, no DOI**


**Magazine article from a library-subscription, full-text DATABASE**

WEB RESOURCES

Journal article on a website, NOT from a library subscription, full-text database

Newspaper article, online version, NOT from a library-subscription database

Website, author unknown, no date

Website, author known

Website of an association

Wiki, where source material may change
Conference paper from a website

Government report on a website with author known

Statistics Canada report on a website

Course website/Moodle site

Online forum post, author’s screen name only available
**Weblog/blog post, author’s proper name available**


**Weblog/blog post, author’s screen name only available**


**VIDEO AND AUDIO**

**Motion picture (videorecording in VHS or DVD format)**


**Audio recording (cassette recording or CD format)**


**Music recording (cassette recording or CD format)**


**Video weblog post (YouTube), author’s proper name available**


**REFERENCE EXAMPLES: VIDEO AND AUDIO**
Video weblog post (YouTube), author’s screen name only available

Audio podcast

IMAGES AND OTHER
Personal communication (letters, emails, personal interviews, phone conversations)
Do not include personal communication, such as letters, memos, emails, personal interviews and telephone conversations, in the reference list. Cite the personal communication in the text, and include the author’s initials in addition to the author’s last name and provide a date that is as specific as possible.

Classical works (such as the Bible, Qur’an)
Do not include classical works such as the Bible, Qur’an or ancient Greek and Roman works in the reference list. Cite the work in the text. You may cite the year of the translation or version you used.

Figure reprinted from a journal (includes charts, graphs, photographs, drawings or other depictions, NOT tables)

If you cannot find the type of source you are looking for, check the NorQuest Library website (http://libguides.norquest.ca/apa6), or ask the librarians for help.
Sample Engl 2550 2c Critical Analysis (Research Essay)

The following is an example of a Critical Analysis essay for English 2550 (Assignment 2c). For a clearer sense of how the essay appears in Word, see the NorQuest Library online APA website.

Keep in mind that while this example contains a section about the history of embalming, students are not required to include a similar section in their own essays.
Abstract
Current day embalming standards use high amounts of formaldehyde, which is toxic to the health of funeral workers, medical students and the environment. The use of formaldehyde can be significantly reduced or eliminated while still producing a high quality preserved cadaver. Conservation or natural burials, where the embalming process is eliminated, must become an option for those planning funerals. With so many alternatives for cadaver preservation, the use of formaldehyde is unnecessary.
Embalming: The Negative Effects of Formaldehyde

Funeral plans may affect the health of the funeral workers and the environment in general. Today the process of planning a funeral seems almost mechanical: embalm the body, view the body, and bury the body, all without consideration as to how this will affect the health of the public and the environment. Because current standards for embalming use high concentrations of formaldehyde, a substance that is toxic to individuals and the environment, the procedures for cadaver preservation must include the reduction or elimination of the use of formaldehyde.

The History of Embalming

Shortly after death, body changes begin to happen at a chemical and physical level that cause alterations (such as decomposition) to the body both internally and externally (Khourii, 2012). The most common method to delay the decomposition of the body is embalming. Embalming has been used for thousands of years in various parts of the world, but it did not become common practice in North America until after the American Civil War. At that time, Dr. Thomas Holmes was asked to create a way to preserve the deceased soldiers’ bodies to allow them to be transported back to their loved ones (Chiapelli & Chiapelli, 2008). His original embalming mixture contained arsenic, a venomous chemical that was known to cause sickness and disease. This
embalming technique was used until the early 1900s when the harmful effects of arsenic caused it to be banned for the use of embalming (Chiappelli & Chiappelli, 2008). What replaced this formula was formaldehyde, another lethal chemical.

**Dangers of Formaldehyde**

Due to its toxicity, many known diseases have been directly linked to long-term formaldehyde exposure. Chiappelli and Chiappelli (2008) state, “[t]he modern practice of embalming replaces organic blood with various toxic and carcinogenic chemicals, particularly formaldehyde” (p. 24). According to the United States Occupational Safety and Health Administration, formaldehyde is listed as a toxic chemical, and for good reason. The Administration states that over an eight-hour work day the maximum formaldehyde exposure level should be no more than 0.75 ppm. An average embalmer is exposed to approximately 9 ppm during the embalming process, more than twelve times the recommended ‘safe’ amount (as cited in Chiappelli & Chiappelli, 2008).

**Long-Term Health Effects**

Excessive exposure to formaldehyde is common among funeral workers, specifically embalmers who handle high amounts of this cancer-causing substance on a daily basis. Iserson found that “embalmers are at a significantly greater
risk than the general populace of getting cancers of the skin, brain, colon, sinuses, nose, throat and blood, kidney failure, arteriosclerotic heart disease, chromosomal damage and cirrhosis of the liver” (as cited in Chiappelli & Chiappelli, 2008, p. 25). Due to the high exposure levels, many known diseases caused by formaldehyde frequently affect embalmers.

**Short-Term Health Effects**

While there are many long-term effects of formaldehyde exposure, the immediate effects felt during or shortly after exposure are just as concerning. As formaldehyde fumes are often inhaled, irritations of the upper respiratory tract are a common complaint among embalmers, as well as a burning feeling in the nose and throat (Khouri, 2012). Even though protective clothing and masks are worn in the embalming room, formaldehyde is still able to cause ill effects to the funeral workers. Other common short-term ailments include nasal, eye and skin irritations, bad taste in the mouth, dizziness, headache, nausea and vomiting (Khouri, 2012). Some people have a high tolerance to formaldehyde and may not notice any of these symptoms, while others may experience many, even if only exposed for a minimal amount of time. Even though symptoms may not be felt immediately, ongoing exposure to formaldehyde can lead to serious health problems later.
Workers at Risk

Along with funeral workers, medical and nursing students are also at risk for higher than recommended exposure to formaldehyde. Visiting a cadaver lab is a common and important part of most medical and nursing programs. Embalming the body beforehand delays decomposition, allowing the required time for students to dissect and study the body (Khouri, 2012). Often, higher amounts of formaldehyde are introduced into cadavers being used for medical study to prevent decomposition for weeks, as opposed to several days as when preparing for a funeral. Despite the many apparent risks, formaldehyde is still commonly used for cadaver preservation.

Environment at Risk

Formaldehyde should also be banned due to its harmful effects on the environment. Most modern day cemeteries are well kept and aesthetically pleasing, but beneath the manicured lawn lies a toxic wasteland of formaldehyde. In the United States alone, two million people are embalmed every year, leading to approximately seven million gallons of formaldehyde being buried (Chiappelli & Chiappelli, 2008). Concerned mainly about the embalming process, Harker (2012) claims that “contemporary funeral practices and cemeteries are ecologically problematic. Digging in a modern cemetery in the United States is much like digging
through a toxic waste site” (p. 151). He states that in North America it is common for a body to be embalmed with formaldehyde, placed in a casket made of hardwood and/or steel that is placed in a vault consisting of steel and reinforced concrete. After the burial, cemetery workers maintain the grounds by using excessive amounts of water and fertilizer to keep the grass looking pristine (Harker, 2012). The pollutants from the formaldehyde, casket, vault and fertilizer will, over time, leach into the groundwater.

**Alternatives to Embalming**

In North America, embalming is the standard method for body preservation; however, other options are available. The necessity of embalming is a common misconception; in most cases, embalming is not legally or medically required. Funeral director Edith Froment explains that while the regulations vary between provinces, in British Columbia embalming is legally required only when the body is leaving the province (personal communication, June 18, 2014).

**Modifying the Formaldehyde Formula**

Since the current way bodies are embalmed is problematic, new formulas to make the embalming process less harmful need to be explored and implemented. Studies are being completed in search of new cadaver preservation techniques, and one particular study done by Khouri (2012), using a minimal amount of formaldehyde,
was very successful. The new formula introduced by Khouri contained much less formaldehyde than the current embalming mixture, at 0.5% vs a 5% concentration that is commonly used (Khouri, 2012). He claims that “this modified formula yields a high quality preserved cadaver with high flexibility and color presentation. A reduction of unwanted ambient hazardous toxic effects of formaldehyde and other chemical fumes was achieved” (Khouri, 2012, p. 32). During Khouri’s study it was also noted that “a significant percentile reduction was observed in all the symptoms that the students complained of, especially with respect to the unpleasant smell and nasal, skin, and eye irritations when the new embalming formula was introduced” (Khouri, 2012, p. 34). As part of the test, the rooms containing the embalmed bodies were measured for formaldehyde readings. The cadavers embalmed with the old formula had readings up to 2.57 ppm, while one of the rooms that contained the new formula had no detection of formaldehyde whatsoever (Khouri, 2012, p. 38). Modified embalming formulas are available and effective, and should be introduced into the funeral industry.

Freezing

Chiappelli and Chiappelli (2008) found that “freezing is the most viable alternative for preventing decomposition in the short term. It preserves the body in a way that does not
require toxic chemicals” (p. 26). Iserson also argues that “other alternatives that preserve the body and prevent odors include packing the body with dry ice and placing the body in a waterproof pouch with lime” (as cited in Chiappelli & Chiappelli, 2008, p. 27). Both of these methods are intended for short-term use. By continuing to use the current embalming standard for cadaver preservation, funeral workers, medical students, and the environment will continue to be exposed to formaldehyde. Quality cadaver preservation can be done without the use of this toxic chemical.

**Green Burials**

The terms conservation, natural or green burials are almost unheard of in North America, where the concept of a traditional funeral is dominant. A conservation burial can be described as “using a biodegradable casket [such as bamboo] without a vault for burial and no embalming fluids in the body” (Harker, 2012, p. 154). Unlike traditional burials, a conservation burial does not introduce contaminants into the environment, and allows for plants and wildlife to flourish naturally. The common manicured look of the modern day cemetery is replaced with a more natural, ecological image of trees, bushes, and plants. Harker (2012) explains that by eliminating the embalming process before burial, the cadaver is returning
nutrients to the land, rather than causing further destruction that a traditional burial will do. Conservation burials not only honour loved ones, but honor the health of funeral workers and the environment. Funeral homes need to offer conservation burials, because the overall exposure of toxic chemicals will be significantly reduced.

**Conclusion**

New methods of body preservation should be put into place for the safety of funeral workers, medical students, and the environment. The current use of formaldehyde for cadaver preservation is unnecessary, as nontoxic options have been proven to be just as effective. End-of-life services should adopt new embalming practices or eliminate the process altogether by offering conservation burials, where the environment is not jeopardized by the mass burial of formaldehyde. It is imperative that the funeral industry take responsibility for implementing these much needed changes and, by doing so, the health of the public and the environment will be richer.
References


Khouri, N. (2012). Management of chemical health hazard fumes emitted during and after embalming procedure and its impact on medical students and embalmers. *Civil & Environmental Research, 2*(8), 32-40. doi:9766AH249/44-87T
Index

Abstract, 13
   formatting, 14
Academic integrity, 9
And or ampersand (&), 53, 55-56
Appendix, 18-19
Assignments
   formatting body text, 14
   order of components, 12
   sample assignment 2c, 76
Authors
   group as author, 41, 56, 64
   multiple authors, 55
   names with suffixes, 54
   names with lettered credentials, 54
   no author name, 54

Block quotations, 42–43
Broadview Anthology of Expository Prose
   (2nd ed.), 43, 63
Brochure
   in appendix, 18
   citation, 19
   reference entry, 69

Citations, 39
   Broadview Anthology, 43
   indirect citation, 44
   multiple authors, 55
   no author, 40
   no date, 40
   no page numbers, 40, 48
   paraphrasing, 40, 45
   structure, 39
Citation examples (in text)
   article in edited book, 47
   audio podcast, 51
   audio recording, 50
   author unknown, 47
   Bible (see classical works)
   blog post, author name available, 50
   blog post, author screen name available, 50
   book in more than one volume, 46
   book with reprinted material from
      a book, magazine or journal in a
      collection, 47
   brochure with no publication date, 48
   chapter, article, essay, story, or poem
   in a collection or edited book, 47
   charts and graphs (see figure)
   classical works (Bible, Qur’an), 51
   course website/Moodle site, 50
drawings (see figures)
e-book (cite depending on number
   of authors)
encyclopedia entry, author known, 47
encyclopedia entry, author unknown, 48 (see also online encyclopedia)
figure reprinted from a journal, 51
figure reprinted from a website, 52
government report, publisher same as
   author, 48
group author as publisher
   (company, association, institution,
   government), 47
Moodle site, 50
movie, 50
newspaper article with letter before
   page number, 48
one author or editor, 46
online encyclopedia, not from a
   library-subscription database, 49
online forum post, author’s screen
   name only available, 50
personal communication, 51
photograph (see figure)
poem in edited book/anthology, 47
reprinted material, 47
six or more authors or editors, 46
Statistics Canada report on a website,
   49
story in edited book/anthology, 47
three to five authors or editors, 46
two authors or editors, 46
YouTube video, author’s proper name
   available, 50
YouTube video, author’s screen name
   only available, 50
website page of an association, 49
website, author known, 49
website, author unknown, no date, 49
Wikipedia, 49

Date of publication, 39, 40, 43, 56
Different first page
   in Word for Mac, 35
   in Word for PC, 24
Document formatting, 11
DOI (digital object identifier), 59, 60, 67, 69
Double spacing
   in Word for Mac, 31–33
   in Word for PC, 21–22
Editions, 62, 65
Editors, 54, 62, 65–66
Font, 14
   in Word for Mac, 30
   in Word for PC, 20
Formatting in Word (see Word formatting)
Group as author, 41, 56, 64
Group as publisher, 47, 65
Hanging indent
   in Word for Mac, 37, 38
   in Word for PC, 28, 29
Headers
   in Word for Mac, 35
   in Word for PC, 24
Headings (see section headings, 16)
Indents
   see hanging indent or paragraph indent
Indirect citation, 44
Italics, 41, 57–58
Line spacing
   in Word for Mac, 31–32
   in Word for PC, 21–22
Margins, 14
   in Word for Mac, 34
   in Word for PC, 23
Multiple authors, 55
No Author, 40–41, 54, 66, 67
No Date, 19, 41, 49, 68, 69, 71, 72
Order of essay components, 12
Order of names, 54
Order of reference entries, 17–18, 54
Page breaks
   in Word for Mac, 37
   in Word for PC, 26
Page layout, 11, 14
Page numbers
   in Word for Mac, 36
   in Word for PC, 25
   in Reference entries 60, 62
   letter before number, 69
   pp., 59, 60, 61, 62, 63
Paragraph indentation, 14
Paragraph spacing
   in Word for Mac, 31–32
   in Word for PC, 21
Paraphrasing, 40, 45
Personal communication (emails, interviews, etc.), 51
Plagiarism, 9
Publication dates, 39, 40, 43, 56
Publisher & location, 62–63
Punctuation
   block quotations, 42
   citations, 41
Quotations, 41, 42
Quotation, citing a, 39, 44
Reference entries
   author names, 53, 64
   components, 53
   DOIs (digital object identifiers), 60
database article URLs, 61, 69
e-books, 67
editions, 62
   editors instead of authors, 54
   editors, 62
group as author, 64
   issue number of journals, 60
   lettered credentials in names, 54
   no author name, 54
   no publication date, 56
   order of names, 54
   page numbers, 60, 62
   place of publication, 62
   publication year, 56
   publisher name, 63
suffixes in names, 54
title capitalization, 57–58
title formatting, 57–58
URLs (web address), 60, 64
   list for database articles, 61, 69
   list for e-books, 67
volumes (books), 62
volume number (journals), 59
Reference entry examples
article in a scholarly journal (database or web), 59, 70, 71
article in an edited collection, 61, 66
audio podcast, 74
audio recording (cassette or CD), 73
book (edition) with eight or more authors or editors, 65
book (edition) with up to seven authors or editors, 65
book by a group author as publisher, 65
book in more than one volume, 65
book with editor(s) instead of author, 65
book with one author, 65
book with reprinted material in a collection, 63, 66
brochure with no publication date, 69
chapter, article, essay, story, or poem in a collection or edited book, 61
charts and graphs (see figure)
conference paper from a website, 72
course website/Moodle site, 72
drawings (see figure)
e-book entry or chapter from a library-subscription database, 67
e-book entry with no author from a library-subscription database, 67
e-book from a library-subscription database, 67
e-book from a website, not from a library subscription, full-text database, 68
editorial in magazine or newspaper (print), 69
encyclopedia entry, author known, 66 (see also online encyclopedia)
encyclopedia entry, author unknown, 66
figure reprinted from a journal, 74
figure reprinted from a website, 75
government report on a website with author known, 72
government report, publisher same as author (print), 69
journal article (2 authors) (print), 68
journal article (more than 7 authors) (print), 69
journal article from a library-subscription, full-text database, no DOI, 70
journal article on a website, not from a library subscription, full-text database, 71
journal article with a DOI (digital object identifier), 70
journal article, (1 author) (print), 68
journal article, (3–7 authors) (print), 68
journal article, no issue number, 68
magazine article (print), 68
magazine article from a library-subscription, full-text database, 70
Moodle site, 72
movie, 73
music recording (cassette recording or cd format), 73
newspaper article (print), 69
newspaper article, online version, not from a library-subscription database, 71
online encyclopedia, not from a library-subscription database, 68
online forum post, author's screen name only available, 72
photograph (see figure)
poem in an edited collection, 66
Statistics Canada report on a website, 72
story in an edited collection, 66
video weblog post (YouTube), author's proper name available, 73
video weblog post (YouTube), author's screen name only available, 74
weblog/blog post, author's proper name available, 73
weblog/blog post, author's screen name only available, 73
website page of an association, 71
website with a known author, 64, 71
website, author unknown, no date, 71
wiki, where source material may change, 71
Wikipedia (see wiki)
YouTube video (author proper name available), 73
YouTube video (author screen name available), 74
References page, 17, 53
(see also hanging indent)
example, 17
formatting, 18
in Word for Mac, 37
in Word for PC, 28, 29
order of names, 12
Running heads, 11
different first page, 24
in Word for Mac, 35
in Word for PC, 24, 27

Section headings, 16

Title page, 12, 26
formatting, 13
sample title page, 13
Titles, 57
capitalization, 57–58
italics, 41, 57–58
quotation marks, 41, 57–58

URLs, 60–61, 64
for database articles, 61, 69
for e-books, 67

Wikipedia, 49, 71
Word Formatting
Word 2011 for Mac, 30
Word 2013 for PC, 20